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This book was written following a series of classes given
by the author to people who had never used a computer
before. Their needs and experiences form the basis of the
book.

It will guide you in your first steps with your new computer.
Explanations are in simple English without jargon.
Chapters are short and deal with only one thing at a time.

lllustrations show you, as far as possible, exactly what you
will see on your computer screen.

Step-by-step instructions make everything easy to follow
and understand.

Using this book, you will learn how to:

e Use the computer and the mouse,

e Write a letter or document and print it out,

e Send email to your friends and relations,

e Receive email and reply to email messages,

e Use the Internet for information and entertainment,

e Play a music CD or a video DVD... and more.

Why should you put off learning how to use a computer, now that
they are to be found in practically every home and office?
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CHAPTER 1

The Computer

This chapter describes the computer
and what it can be used for.
You will learn about the different

parts of a computer and what they
are for.
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A computer is just a machine like any other. You can learn to
use a computer just as you can learn to use any other machine.
However, there are some people who regard computers as
being ‘difficult’. Perhaps this is because many people try to use
a computer with little or no instruction on how to use it. Hence
the fear and alarm when something unexpected happens and
they do not know what to do.

But now that computers are so widely used, both in the home
and in the workplace, why not learn a little about them?@

If you see the computer for what it is and take a little time to
learn how to use if, your interests can be enriched and your work
reduced... and it can be a fulfilling and happy experience.

ARE COMPUTERS EASY TO USE?

Yes. When you have learnt the basic skills — and they really are
basic — modern computers are easy to use. Long ago, however,
computers were very difficult for ordinary people to use. All
that appeared on the screen then was text — and only text.
Instructions had to be typed in using the keyboard in a special
code to get the computer to do anything.
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CHAPTER 2

The Mouse

This chapter tells you more about the
mouse.

It describes how it works and how to
use it.
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The Mouse

N

While the mouse is off the mat, the pointer on the screen stays
where it is and does not move.

When you return the mouse to the centre of the mouse
mat, the pointer moves again — as you move the mouse - to
complete your original intention.

USING THE MOUSE

The mouse is deceptively simple to use but it will require some
practice before it can be used with ease and confidence.

Using the mouse automatically is the key to confidence in
using the computer. The chapters that follow use programs
already on your computer to give you plenty of practice with
the mouse before you even think of using the keyboard.

The mouse is used for three different things — pointing, clicking
and dragging.
It is most important to know the difference between these

differentactions. Then you willbe able to use the one appropriate
to what you want to do, without having to think about it.

Pointing

Pointing means moving the pointer, usually in the shape of a
small arrowhead, on the screen so that the sensitive part — the
tip of the arrow - rests on an object on the screen.

As you move the mouse, the pointer on the screen moves with it.
You can point to anything on the screen quickly and easily just
by moving the mouse.

To point to something on the screen, move the mouse until
the tip of the arrow rests on the object.
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Painting and
Drawing

This chapter shows you how to use a
program on the computer to draw a
picture.

You will use the mouse to select tools
and colours and to draw simple
shapes.
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THE PAINT WINDOW

The main (white) part of the window represents the blank paper,
or canvas, on which you will draw/paint. The size of the canvas
can be changed by dragging the bottom right-hand corner of
the canvas, only if you want to.

The size of the window can be adjusted, if necessary, as
described in Chapter 4, on page 62.

The tools (brushes, pencils, etc.) are arranged down the left side
of the window.

i§ untitled - Paint

File Edit View Image Colors Help
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Far Help, click Help Topics on the Help Menu,

A selection of colours that you can choose from appears along
the bottom.

You will use the mouse as if it were a pencil or a brush to draw
the picture by pointing, clicking and dragging. As you move
the mouse on the mouse mat, the pencil or brush that you
have selected will do the drawing on the screen.
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THE TOOLS

The tools buttons are described here. Each button has an icon
on it fo remind you of the tool it represents.

Select anirregular area

Eraser for rubbing out

Eye Dropper for picking up colours
Pencil for drawing

Spray can (Airbrush)

Draw a straight line

Draw a rectangle

Draw an ellipse or circle

Choose a tool size
(some tools only)

Painting and Drawing
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Select a rectangular area

Paint Bucket for filling with colour
Magnifying Glass for a closer look
Brush for painting

Write on your drawing

Draw a curved line

Draw an irregular shape

Draw a box with round corners



CHAPTER 7

The Keyboard

This chapter briefly describes the
keyboard and tells you about some of
the keys that you will use most often.
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The Keyboard

If you have used a typewriter, you will see that the computer
keyboard is essentially the same, but with a number of extra
keys. There is also a number pad - like a calculator — on the
right (but not on a laptop computer, where there is not enough
space for it).

The keyboard is often referred to as the QWERTY keyboard
because of the order of the first six letters in the top row of

letters.
S 3 e [5 e 7 ]e
4 )5 7|8
SjalwlE|R|T|[Y]|U

stok| Al s|D|FlG|H|J

Learning to use the keyboard is just AT :
learning to type. There are several LEARN 10 TYPE
computer typing courses, programs e e
that you buy and install on your SID[EGIHUIKILL R |
NP VIBINIMI<[ ] 4
computer to tfeach yourself to type. - ?O
The keyboard is displayed on i / , i B\
the screen, with instructions and —

exercises.

It works as though you had your
own personal futor.
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CHAPTER 8

Writing a Letter

This chapter shows you how to use a
word processor on your computer to
write a short letter.
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Writing a Letter

A computer program called a word processor is used fo write
letters and to prepare documents of all kinds. In this chapfter,
you will use the Microsoft Works word processor.

Using a computer has many advantages, even if your typing
skills are limited.

Typing errors are very easy to correct.
The computer can correct spelling mistakes for you.
You can easily keep copies of all your letters.

Copies of letters can be sent to different people. Some details
can be changed to suit each person, without having to type
out everything again.

OPENING MICROSOFT WORKS

This is how to find Microsoft Works if you are opening it for the
first time.

Click the Start button.
The Start menu appears.

194497 D BuljlIMm
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Editing a Document

This chapter shows you how to
reopen a document you have saved
previously and how to make changes
and additions to it.
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Now, with your computer switched on again - if you had
switched it off — you are ready to find and reopen your letter.

FINDING A RECENT DOCUMENT

Microsoft Works keeps a list of the most recent documents that

you were working on.

This makes it easy to find and open them again.

Open Microsoft Works, if it is not already open.

Open the File menu (click the word File in the menu
bar — all letters and documents are files).

@ Untitled Document - Microsoft Works Word Processor

File Edit  Wiew Insert Format  Tools  Table  Help

O new... bl || ¥ B | o o | @ ER

= Open... Chrl+o
Close Chrl+w ]I-j' | B 7 U H;é
E save g pilteec S L e

Save As..,

:Z Page Setup...
& Print Preview
S Prirt... Ctrl+p

= send...

1. ACatherine wps

2. APaul Jones.wps

3T Uncle Peterwps

Look at the bottom of the File menu and you will see
a list of recent files, giving their locations and names.

Click the Catherine file to open it.
The letter appears just as it was when you saved it.

Editing a Document

O
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CHAPTER 11
The Intfernet

This chapter introduces you to the
Internet and describes how your
computer connects to it.

It also describes how Internet pages
work and how to use them.
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The Internet

—

AN INTERNET ACCOUNT

You must have an account with an Internet Service Provider
(ISP) before your computer can connect to the Internet.

The process of setting up an Internet account is not dealt with
here. It is assumed that an Infernet account has been set up for
you and that you are ready fo use it.

A Username and Password will have been allocated to you
when your Internet account was opened. These are used when
you want to connect to the Infernet.

INTERNET EXPLORER

A program called an Internet Browser is used to view pages on
the Internet.

The most widely used browser is Microsoft Internet Explorer. It
normally appears near the top of the Start menu.

If Internet Explorer is not on the Start menu, you will find it on the
All Programs menu.

Click the Internet Explorer button to open it.

. Internet * } My Documents
Internet Explorer

b E-mryail ;} My Recent Documents #
@ Cutlook Express 2
- L—-} My Pictures
@ Calculator J S
The Internet Explorer window appears and displays a page
of information.
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CHAPTER 12

Using the Internet

This chapter guides you in exploring
some pages on the Internet.
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SEARCHING FOR INFORMATION

How can you search for all the information that you are told is
available on the Internet?

The easiest way is to use an Internet Search Engine, such as
Google, which is one of the most popular and widely used.

A search engine takes your request and searches through the
millions of pages available to find those relevant to what you
are looking for. Then it displays the pages in order and presents
them to you with, hopefully, the most relevant pages at the top
of the list.

FINDING GOOGLE

Find Google as follows.

Click anywhere in the white space in
the Address box.

Any address already there is highlighted.

Type www.google.com

It replaces whatever was in the address
box.

Press the Return key on the keyboard or click the Go
button at the end of the address box.

The Google page appears. Note that it may be localised
for your country — Google.ie if you are in Ireland, for
example.
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CHAPTER 13

Email

This chapter tells you about email.
It describes the Outlook Express email
program and shows you how to use it.




FIRST STEPS

When an email message is sent, it does not go directly to the
recipient’'s computer, which is most probably turned off most
of the time anyway.

Instead, it goes to the electronic equivalent of the recipient’s
local post office.

To check for email, your computer contacts your electronic
Post Office. If it finds any email for you, it collects it and brings
it back to your computer.

So, although email can be almost instantaneous in going from
one side of the world to another, how long it takes for you to see
it depends on how often you check your email.

An email address, and a separate username and password o
use with it, may have been allocated to you when your Internet
account was opened.

Your email address is what people use to send messages
to you by email, just as you need a street address so that
people can send you letters by post. You will recognise an
email address because it always has an ‘at’ (@) symbolin it.

Your username is a unique name that identifies you, usually
a version of your name, such as tom or tmacm. A short
username is easier to type and to remember.

Your password, like a bank PIN number, ensures that no one
else can have access to your email.

OUTLOOK EXPRESS

Outlook Express is the program that most people use for email.
It normally appears near the top of the Start menu.

Email

W
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Click the E-mail/Outlook Express button to open it.

If Outlook Express is not on the Start menu, you will find
it in the All Programs menu.

/ Internet _) My Documents
Internet Explorer
b E-mrvail L—-} My Recent Documents »
Cutlook Express

L;J My Pictures

@ Calculator &
L—J My Music

When you open Outlook Express, it connects to the Internet in
the same way as Internet Explorer. There may be a connection
procedure if you use a dial-up connection. Look back at
Chapter 11, page 161) to refresh your memory if necessary.

The Outlook Express Window

Information about Outlook Express is displayed when you open
it for the first time.

¥4 Outlook Express =B

B3

{ fie Edt Wew Took Message Help &
-

¢ Create Mail Send/Recy Addresses Find

w Outlook Express |

Flders 2l NO P——

ﬂ:;! Qutlook Express

1% Local Folders
- ;-@ Inbox Find a Message... Identities v
- Outbox Tip of the day x
- Sent Items E-mail
{7 Deleted Ttems | Use Message

Rules in the
LD Tools menu to

There are no unread Mail messages in your Inbox automatically do
other things
besides sort

Setup 3 Mail account... incorning e-mail
inta folders. Tou

“\N can color certain
. messages,
~ sutomatically
send a certain

Newsgroups reply, even delete
messages.

Set up 8 Mewsgroups account...

I1pw3
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CHAPTER 15

Using Folders

This chapter shows you how to file and
organise your work and help keep your
desktop tidy.
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CREATING FOLDERS

Now you will learn how to create new folders and to save
documents in them.

To open the My Documents folder, do the following.

Click the Start button.
The Start menu appears.

Click My Documents located on the right of the
menu.

4 Internet ’ My Documents
Internet Explorer k
Iﬁl il @ My Recent Documents »

COutlook Express J
'ﬁ My Pictures

@ Calculator 3
'3 My Music
ili Solitaire g My Computer
G My Network Places
E Microsoft Word

@ Microsaft Waorks Word @ Contral Panel
Processar
g Connect To »

34:\
l&’é Printers and Faxes

@) Help and Support

All Programs P

['E| Log OFF |6| Turn OFF Computer

The My Documents window opens.

Using Folders

O
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